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АННОТАЦИЯ 

Данный документ содержит информацию, предназначенную для 

оператора программного обеспечения. Здесь приведены условия запуска и 

выполнения программы, подробный алгоритм работы, а также указаны 

возможные сбои в ходе работы и порядок действий при их возникновении. 
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 Список сокращений 

РЛИ – радиолокационное изображение 

ЧПИ – частота повторения импульсов 
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1 Назначение программы 

1.1 Назначение и функции, выполняемые программой  

Назначение ПO Радиошоп заключается в пакетной обработке 

радиолокационных данных различных диапазонов (Р и Х диапазонов) по 

заранее сформированному сценарию. Полный цикл обработки, 

обеспечиваемый ПО включает в себя: копирование исходных данных из 

памяти устройства-носителя или радиолокационного комплекса, 

систематизация и сохранение результатов работы в локальной памяти, 

проведение первичной, вторичной и адаптивной обработки данных и 

визуальное отображение результатов работы оператору. 

ПO Радиошоп имеет функцию взаимодействия с радиолокационным 

оборудованием для получения информации, регистрируемой во время 

выполнения радиолокационной съемки РСА Х- и P-диапазонов в виде 

радиоголограмм и навигационных данных. 

ПО Радиошоп обеспечивает выполнение следующих функций: 

• копирование радиоголограмм и навигационных данных, полученных 

во время выполнения радиолокационной съемки РСА Х- и P-

диапазонов, из памяти устройства-носителя или радиолокационного 

комплекса; 

• предварительная обработка данных, в том числе фильтрация 

исходных данных; 

• первичная обработка данных: приведение типов данных, 

демодуляция и согласованная фильтрация сигнала в соответствии с 

форматом файла радиоголограммы; 

• вторичная обработка данных с фиксированной задержкой, которая 

реализует классический алгоритм синтеза апертуры; 



 

оооооо6 - 6 - 6 

Л

ист 
 Изм. Лист   № докум.        Подп.      Дата 

6 643.29689459.00074-01 34 11 
Л

ист 

Ин
в.
 №

  
по

дл
.  

  
  

  
  

По
дп

. и
 д

ат
а 

  
  
  

  
  

  
  

  
  

Вз
ам

. и
нв

. №
  

  
  
  

  
Ин

в.
 №

 д
уб

л.
  

  
  

  
  

По
дп

. и
 д

ат
а 

 

Лист 

• вторичная адаптивная обработка данных, использующая комплекс 

алгоритмов автофокусировки изображения, а также 

вспомогательные методы, направленные на снижение уровня 

искажений сигнала; 

• преобразование динамического диапазона (ПДД) РЛИ в 256 градаций 

серого для отображения на экране. 

ПО Радиошоп имеет графический интерфейс оператора, посредством 

которого оператор имеет доступ ко всем выполняемым ПО функциям. 

Интерфейс ПО Радиошоп обеспечивает выполнение следующих функций: 

• отображение на экране синтезированных РЛИ и сопутствующих 

данных; 

• масштабирование (увеличение или уменьшение масштаба) 

отображения РЛИ; 

• перемещение отображаемого РЛИ в рабочем поле отображения при 

масштабировании; 

• отображение координат положения курсора на РЛИ; 

• сохранение отображаемого РЛИ в файл; 

• выделение выбранного фрагмента РЛИ и его сохранение в файл; 

• преобразование динамического диапазона РЛИ с целью обеспечения 

максимальной информативности при отображении; 

• регулировка яркости и контрастности РЛИ; 

• высокодетальный режим обработки радиоголограммы, выбранной 

оператором, с возможностью ручной калибровки параметров 

обработки; 

• построение набора двумерных функций отклика на точечную цель; 
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• определение значений фактической разрешающей способности по 

поперечной координате и по наклонной дальности; 

• вычисление диаграммы направленности антенны по ансамблю 

данных путем построения усредненного пространственного спектра 

сигнала; 

• оценка уровня шумов данных по участкам их априорного отсутствия; 

• оценка полосы захвата; 

• оценка динамического диапазона синтезированного РЛИ путем сбора 

статистики по ансамблю данных на одной радиоголограмме. 
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2 Условия выполнения программы 

2.1 Программное обеспечение, необходимое для функционирования 

программы  

Для функционирования ПО требуются: 

• ОС Ubuntu, минимальная версия 20.04 

•  Драйвер Nvidia Video Driver, минимальная версия 430 

• Библиотеки: 

o прикладные:  

▪  RLI Synthesis Library  

▪  Real Time Library 

▪  Real Time Synthesis Library 

▪  Python RLI Synthesis Library 

o системные: 

▪  qt5,  

▪  libcrypto++  

▪  libjsoncpp 

▪  libfftw3 

▪  libgoogle-perftools  

▪  qtdeclarative5 

▪  imagemagick 

o модули Python: 

▪  pip 20.0.2 

▪  torch 1.5.1 

▪  torchvision 0.6.1 
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▪  PyCrypto 2.6.1 

▪  gcg 0.2.0 

▪  gitdb 4.0.5 

▪  GitPython 3.1.9  

▪  PySide2 5.14.0 

▪  imageio 2.5.0 

▪  matplotlib 3.0.3 

▪  nose 1.3.7 

▪  numpy 1.17.0 

▪  pkgconfig 1.5.1 

▪  Pillow 6.1.0 

▪  pybind11 2.3.0 

▪  python-rlisynt 0.0.1 

▪  scikit-image 0.15.0 

▪  scipy 0.18.1 

▪  mypy 0.761 

▪  mypy-extensions 0.4.3 

▪  wheel 0.34.2 

2.2 Языки программирования, на которых написана программа  

Для написания программы использовался язык Python. Графический 

интерфейс пользователя для программы написан на языке QML. 

2.3 Используемые технические средства 

Для функционирования ПО требуется компьютер с архитектурой x86-

64, удовлетворяющий следующим техническим характеристикам: 

•  64-разрядный (x64) процессор Intel Core i7; 

• 32 ГБ ОЗУ;  

• видеокарта не ниже GeForce RTX 2060 Super. 
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3 Выполнение программы 

3.1 Структура директорий 

Если был произведен синтез одной или нескольких голограмм из 

рабочей директории, то в ней создается каталог .synth_data, а в нем – подпапки 

с именами, соответствующими имени голограммы. Каждая такая подпапка 

содержит файлы РЛИ в формате .rli и .jpg, а также .json-файл с метаданными. 

3.2 Описание интерфейса 

3.2.1 Окно приветствия 

При запуске программы отображается окно приветствия, показанное на 

Рисунке ниже. 

Рисунок 3.1 – Окно приветствия 

В левой части окна отображается список последних рабочих директорий. В 

правой части расположены три кнопки:  

▪ Create New Workspace — создание новой рабочей директории 

▪ Open Workspace — открытие существующей рабочей директории 

▪ Open File — открытие отдельного файла РЛИ 
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В правом нижнем углу отображается системная информация: объем свобод-

ного места на диске, объем свободной видеопамяти и др. 

3.2.2 Обозреватель 

При выборе рабочей директории в приветственном окне программы открывается 

окно Обозревателя, общий вид которого показан на Рисунке ниже. 

Рисунок 3.2 - Окно Обозревателя программы Радиошоп 

Данное окно предназначено для отображения результатов синтеза 

радиолокационных голограмм и последующих обработок, а также для выбора 

дальнейших действий над полученными РЛИ. 

Центральную часть окна занимает таблица с миниатюрами РЛИ, 

полученных в результате синтеза. Изображения можно выбирать группой 

кликом мыши с зажатым Ctrl или Shift на клавиатуре или средствами панели 

действий. По двойному клику на миниатюре выбранное РЛИ открывается для 

дальнейшей обработки во вкладке WorkSpace. 
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На панели слева расположена таблица с характеристиками голограммы 

и параметрами обработки (размеры голограммы, ЧПИ, параметры 

автофокусировки, средняя скорость и др.).  

Панель инструментов позволяет выполнять следующие действия: 

−  - импорт данных 

−  - выбрать все объекты в таблице 

−  - синтез РЛИ 

−  - экспорт результатов 

−  - переименовать объект в таблице 

−  - удалить объект из таблицы 

3.2.3  Рабочая область 

Общий вид окна программы во вкладке WorkSpace показан на Рисунке 

ниже. 

 

Рисунок 3.3 - Общий вид вкладки WorkSpace 
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Данная вкладка предназначена для обработки РЛИ, полученных в 

результате синтеза, и вычисления различных технических характеристик 

(ширина полосы захвата, разрешающая способность и др.). В число подобных 

обработок РЛИ входит применение методов ПДД, регулировка яркости и 

контрастности изображения. 

Под панелью вкладок расположена панель инструментов. Она 

включает в себя следующие пункты: 

 - предназначен для выделения области РЛИ. 

 - предназначен для вычисления ширины полосы захвата. 

 - предназначен для оценки динамического диапазона РЛИ. 

 - предназначен для вычисления диаграммы направленности 

антенны по ансамблю данных путем построения усредненного 

пространственного спектра сигнала и отображения графика 

спектра в абсолютных или логарифмических величинах. 

В правой части окна расположены панель гистограммы, панель 

регулировки яркости/контрастности, панель слоев и панель истории слоя. 

Панель гистограммы отображает текущие границы преобразования 

динамического диапазона (ПДД) и текущую гистограмму изображения для 

активного слоя. Панель слоев позволяет переключать их видимость, добавлять 

и удалять слои, менять их прозрачность, взаимное расположение, изменять 

настройки сценариев. Панель истории слоя дает возможность переключаться 

между всеми изменениями слоя, произведенными в панели слоев и на панелях 

гистограммы и регулировки яркости/контрастности. 

В центральной части окна расположена область отображения РЛИ. Она 

позволяет просматривать РЛИ и результаты его обработок, перечисленных на 

панели слоев. Отображаются только видимые слои (с не перечеркнутым 

"глазом"). Перемещать изображение можно используя левую кнопку мыши. 
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Изменять масштаб можно с помощью колеса мыши, а также используя панель 

масштаба, расположенную на строке состояния. 

В самом низу окна находится строка состояния. На ней отображаются 

текущие координаты курсора, размеры текущего слоя и выделенной области. 

По центру строки расположен прогресс бар. Он активен, если выполняется 

какая-либо обработка. Если в данный момент обработок не выполнятся, то 

прогресс бар скрыт. В правой части строки состояния находится панель для 

изменения масштаба и для его быстрого переключения (Рисунок 3.4). 

 

 

Рисунок 3.4 - Строка состояния 

3.3 Сценарии использования 

3.3.1 Первичная и вторичная обработка данных 

ПО Радиошоп обеспечивает выполнение следующих функций 

первичной обработки данных: 

•  предварительная обработка данных, в том числе фильтрация 

исходных данных; 

•  первичная обработка данных, т.е. приведение типов данных, 

демодуляция и согласованная фильтрация сигнала в соответствии с 

форматом файла радиоголограммы. 

Вторичная обработка включает в себя: 

•  адаптивная обработка данных, которая использует комплекс 

алгоритмов автофокусировки изображения с целью получения 

радиолокационных снимков максимального качества по 

пространственному разрешению, уровню шумовой составляющей; 
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•  вспомогательные методы, направленные на снижение уровня 

искажений сигнала (как геометрических, так и искажений спектра 

сигнала); 

•  преобразование динамического диапазона (ПДД) РЛИ в 256 

градаций серого для отображения на экране; 

•  коррекция распределения яркости РЛИ на экране с учетом 

геометрии съемки. 

Для выполнения данных обработок необходимо выполнить следующие 

действия. 

 

3.3.1.1 Открытие папки с данными 

Если рабочая папка с голограммами уже существует на рабочем диске 

комплекса, её можно открыть, выбрав в меню File->Open folder, либо выбрав 

ее из списка Open recent в окне Welcome.  При этом появится диалог пакетной 

обработки, в котором отображен список голограмм и размеры их файлов 

(Рисунок 3.5).  
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Рисунок 3.5 - Диалог пакетной обработки 

В диалоге имеется возможность выбрать голограммы для обработки и 

установить такие параметры как частота подсчёта параметрической скорости и 

размер блока для подсчёта. Если голограммы уже обработаны, они будут 

присутствовать в списке, однако будут не отмечены. 

После нажатия кнопки OK будет выполнена пакетная обработка 

данных, включающая в себя согласованную фильтрацию (если необходимо), 

адаптивную обработку данных и линейное преобразование динамического 

диапазона, в результате чего в окне обозревателя должны появиться 

миниатюры полученных изображений. 

3.3.1.2 Импорт данных из другого места файловой системы 

Если данные для обработки находятся в другом месте файловой 

системы, например, на другом диске, на сменном носителе, их можно 

импортировать в текущую рабочую папку программы для последующей 

обработки.  
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Для этого во вкладке Browser на панели инструментов необходимо 

выбрать кнопку Import files, а в появившемся списке выбрать один из 

следующих вариантов: 

• Import files — импорт одного или нескольких выбранных файлов 

• Import folder — импорт директории с файлами 

После этого, так же, как и в п. 3.3.1.1 появится диалог пакетной обработки. 

Отличие заключается в том, что перед началом обработки голограммы будут ско-

пированы в текущую рабочую папку. 

3.3.1.3 Импорт данных из радиолокатора 

Импорт данных из радиолокатора имеет особенность в том, что при 

копировании данных производится их преобразование из формата 

радиолокатора во внутренний формат программы. 

Для импорта данных из радиолокатора или его съёмного носителя 

необходимо во вкладке Browser на панели инструментов выбрать Import files, а 

из появившегося списка - Import flight. 

После этого, так же, как и в п. 3.3.1.1 появится диалог пакетной 

обработки. После нажатия кнопки OK данные будут скопированы, 

преобразованы и обработаны. 

3.3.2 Информация об обработке 

При выделении какого-либо РЛИ в основной таблице на панели слева в 

виде таблицы отображаются характеристики голограммы и параметры 

обработки:  

• средняя скорость, вычисленная в процессе автофокусировки 

•  угол доплера 

•  исходное и текущее значение ЧПИ 
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•  частота подсчёта параметрической скорости для алгоритма 

автофокусировки 

•  размер блока по азимуту для автофокусировки 

•  размеры голограммы 

• размер отступа по дальности 

 

 

Рисунок 3.6 - Таблица с информацией об обработке 

3.3.3 Работа с несколькими РЛИ 

Когда есть необходимость выполнять какие-либо действия над набором 

обработок (экспорт, пересинтез и др.), следует сначала выделить их 

миниатюры в основной таблице. Для этого предусмотрены следующие 

возможности. 
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Выделить несколько обработок таблицы можно, зажав кнопку Ctrl на 

клавиатуре. Несколько последовательных объектов в таблице можно выделить, 

зажав кнопку Shift. Все элементы таблицы можно выделить, выбрав пункт 

Select all на панели инструментов в верхней части вкладки Browser. 

После выделения необходимых РЛИ на панели инструментов можно 

выбрать нужную операцию и нажать соответствующую кнопку. Выбранное 

действие выполнится для всего выделенного набора РЛИ. 

3.3.4 Высокодетальная обработка выбранной радиоголограммы 

Если полученные результаты синтеза РЛИ неудовлетворительны, 

можно запустить синтез, изменив необходимые параметры. Для этого следует 

на панели инструментов выбрать меню Synthesis, в появившемся окне синтеза 

изменить необходимые значения параметров и запустить синтез (Рисунок 3.7). 

 

Рисунок 3.7 - Диалог пакетной обработки 
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Для более точного и детального вычисления скорости необходимо 

увеличить частоту подсчёта параметрической скорости для алгоритма 

автофокусировки. 

3.3.5 Экспорт 

Для экспорта результатов синтеза или постобработки РЛИ необходимо 

на панели инструментов выбрать меню Export и в появившемся окне экспорта 

выбрать необходимый формат файлов, их размер, директорию сохранения и 

др. 

Рисунок 3.8 - Окно экспорта 

3.3.6 Удаление результатов 

Если полученный результат обработки по некоторым критериям не 

подходит для последующего рассмотрения, его можно убрать из основной 

таблицы, выбрав пункт Delete на панели инструментов или соответствующий 

пункт контекстного меню по правой кнопке мыши на соответствующем РЛИ. 

3.3.7 Просмотр РЛИ 

По двойному клику на миниатюре РЛИ в основной таблице вкладки 

Browser  РЛИ можно открыть для просмотра и обработки во вкладке 

WorkSpace. 

Для просмотра РЛИ и результатов его обработок, перечисленных на 

панели слоев, предназначена центральная панель. На ней отображаются только 
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видимые слои (с не перечеркнутым "глазом" на панели слоев). Перемещать 

изображение можно используя левую кнопку мыши. 

Изменения масштаба выполняется при помощи колеса мыши, а также 

при помощи панели на строке состояния (Рисунок 3.9). 

 

Рисунок 3.9 - Панель изменения масштаба РЛИ 

Первая кнопка предназначена для применения 100% масштаба, вторая - 

для помещения всего изображения на область отображения РЛИ, третья и 

четвертая - для увеличения и уменьшения масштаба, соответственно. Справа 

от этих кнопок расположен слайдер, позволяющий плавно с шагом 1%, 

изменять масштаб, а также отображающий значение текущего масштаба. 

Также на строке состояния отображаются значения координат текущего 

положения курсора (по дальности - в отсчетах и метрах, по азимуту - в 

отсчетах и секундах), положение и размеры текущего слоя, а также положение 

и размеры выделенной области (при включенном режиме выделения). 
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Рисунок 3.10 - Отображение координат на строке состояния 

3.3.8 Слои и сценарии обработки 

Для добавления нового слоя необходимо на панели слоев нажать "+" и 

выбрать из появившегося списка один из предложенных сценариев (Рисунок 

3.11). 

 

Рисунок 3.11 - Диалог выбора сценария обработки РЛИ 
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После нажатия OK новый слой появится в списке на панели слоев. Для 

удаления слоя следует нажать "-" в нижней части панели (Рисунок 3.12) 

 

Рисунок 3.12 - Панель слоев 

Просмотр и изменение настроек выбранного слоя можно выполнять на 

панели, расположенной под панелью слоев, выбрав соответствующий слой в 

списке слоев. Для включения и отключения видимости слоя предназначена 

кнопка «глаз» слева от его названия. Двойной клик на «глаз» переключает 

видимость слоев в панели таким образом, что видимыми становятся только 

слой с РЛИ (начальный) и слой, на котором был произведен двойной клик. 

Слайдер вверху панели слоев предназначен для изменения 

прозрачности активного слоя. 

Порядок слоев определяет то, в каком порядке они будут отрисованы 

на области отображения РЛИ. Долгое нажатие на слой делает активным его 

возможность перемещения (изменения порядка отображения) между другими 

слоями. Изменение порядка отображения также возможно с помощью стрелок 

на панели слоя в правом нижнем углу. Они перемещают текущий выделенный 

слой. 
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Рассмотрим возможные сценарии обработки. 

1) Linear DR 

При выборе данного сценария создается слой с применением 

линейного ПДД к РЛИ (подробнее в п. 3.3.9). 

2) Normal RLI 

При выборе данного сценария выполняется коррекция яркости РЛИ. 

Фильтр Brightness Compensation обеспечивает плавное выравнивание 

амплитуды сигнала по диапазону значений. Это устраняет неравномерность 

яркости, обусловленную диаграммой направленности антенны или затуханием 

радиолокационных сигналов. 

Если преобразование нужно отключить, следует переключить 

выключатель справа от типа преобразования. 

3) RLI with HDR 

Данный сценарий включает в себя несколько типов преобразований 

РЛИ: коррекцию яркости и преобразование динамического диапазона. 

В данном сценарии помимо компенсации яркости, описанной в 

предыдущем пункте, применяется преобразование динамического диапазона 

до 256 уровней яркости одним из предложенных алгоритмов: Драго или 

Рейнхарда. Выбрать необходимый тип алгоритма можно из выпадающего 

списка под соответствующим типом преобразования. Под названием 

преобразования расположен список параметров, который разворачивается и 

сворачивается по нажатию на треугольник слева от имени преобразования. 

4) Fancy 

Данный сценарий включает в себя следующие типы преобразований 

РЛИ: фильтрацию спекл-шума, коррекцию яркости и преобразование 

динамического диапазона. 
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Вначале выполняется фильтрация спекл-шума одним из предложенных 

алгоритмов: фильтр Ли или размытие по Гауссу. Они используют 

статистические критерии для принятия решения, является ли текущая точка 

спеклом или откликом реального объекта. Затем выполняется компенсация 

яркости РЛИ. Это устраняет неравномерность яркости, обусловленную 

диаграммой направленности антенны или затуханием радиолокационных 

сигналов. И наконец, проводится преобразование динамического диапазона 

одним из предложенных алгоритмов: Драго или Рейнхарда. 

Если какое-либо из преобразований нужно отключить, следует 

переключить выключатель справа от типа преобразования. 

Примечание: также в настройках каждого из сценариев отображаются 

параметры регулировки яркости и контрастности изображения (см. п.3.3.10). 

3.3.9 Преобразование динамического диапазона (ПДД) 

Изначально для преобразования динамического диапазона применяется 

линейный алгоритм. Полученное изображение необходимо для 

предварительного просмотра и создания базового слоя (Linear DR в списке 

слоев). 
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Рисунок 3.13 - Базовый слой с линейным ПДД 

В правом верхнем углу находится панель гистограммы. На ней 

расположена гистограмма входного изображения, а также два ползунка, 

которые задают верхний и нижний пороги линейного ПДД. 

 

Рисунок 3.14 - Панель гистограммы 



 

оооооо27 - 27 - 27 

Л

ист 
 Изм. Лист   № докум.        Подп.      Дата 

27 643.29689459.00074-01 34 11 
Л

ист 

Ин
в.
 №

  
по

дл
.  

  
  

  
  

По
дп

. и
 д

ат
а 

  
  
  

  
  

  
  

  
  

Вз
ам

. и
нв

. №
  

  
  
  

  
Ин

в.
 №

 д
уб

л.
  

  
  

  
  

По
дп

. и
 д

ат
а 

 

Лист 

Пользователь также может вручную установить значения порогов в 

полях редактирования под гистограммой или использовать автоматически 

рассчитанные пороги, нажав кнопку Auto. 

Положением левого ползунка можно регулировать контрастность 

подстилающей поверхности, а правый ползунок отвечает за яркие объекты. В 

большинстве случаев манипулирование обоими ползунками дает возможность 

получить качественные радиолокационные изображения. 

Для более сложных задач программа предоставляет расширенные 

алгоритмы обработки, объединенные в сценарии (см. п.3.3.8). 

3.3.10 Регулировка яркости и контрастности 

Для улучшения различимости объектов на РЛИ и упрощения 

дальнейшей зрительной дешифровки также применяется регулировка яркости 

и контрастности изображения, а также методы нелинейной коррекции яркости. 

Ползунки для регулировки расположены на панели справа. 

Первый и второй ползунки предназначены для изменения яркости и 

контрастности изображения, соответственно. Третий и четвертый - для 

применения гамма- и логарифмической коррекции. В результате этих 

преобразований увеличивается диапазон малых значений яркости, и 

уменьшается диапазон больших значений яркости. Это приводит к тому, что 

объекты фона, которые могли быть не различимы между собой, становятся 

заметны, при этом яркие объекты, которые могли сливаться друг с другом и 

казаться единым целым, становятся также различимы.  

На следующих рисунках приведены примеры применения данных 

преобразований по отдельности (пороги линейного преобразования остаются 

неизменными). На центральной картинке показано исходное РЛИ с 

автоматически подобранными границами линейного ПДД. На рисунках слева и 

справа - результаты уменьшения и увеличения значений соответствующих 
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параметров (яркости, контрастности, гаммы и основания логарифма), 

соответственно. 

 

Рисунок 3.15 - Изменение яркости РЛИ 

 

Рисунок 3.16 - Изменение контрастности РЛИ 

 

Рисунок 3.17 - Применение гамма-коррекции к РЛИ 

 

Рисунок 3.18 - Применение логарифмического преобразования к РЛИ 
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На Рисунке ниже показан результат применения нескольких 

преобразований сразу (в т. ч. после изменения яркости, контрастности и 

применения нелинейной коррекции вручную изменены пороги линейного 

преобразования). 

Рисунок 3.19 - Регулировка яркости и контрастности РЛИ 

3.3.11 История и отмена действий 

Панель истории слоя располагается в правом нижнем углу программы. 

Можно отключить/включить отображение данной панели в меню 

View->Layer history. 

 

Рисунок 3.20 - Панель истории слоя 

Эта панель позволяет переключаться между всеми изменениями слоя, 

выполненными на панели слоев или в гистограмме. Текущее активное 

состояние подсвечено синим цветом (Рисунок выше). Двойной клик по строке 

в истории позволяет переключиться на данное состояние слоя. 
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Переход между состояниями также возможен и через меню 

Layer Edit->Undo/Redo и по соответствующим клавишам Ctrl+Z и Ctrl+Shift+Z 

на клавиатуре. Они переключают на предыдущее/следующее состояния слоя в 

истории действий. 

3.3.12 Работа с фрагментом РЛИ 

Для того чтобы обрабатывать отдельный фрагмент изображения, 

предусмотрено два способа: 

1) сохранение фрагмента в виде отдельного .rli-файла для 

дальнейшего открытия и обработки во вкладке WorkSpace 

2) "вырезание" необходимой части слоя для дальнейшей обработки 

только этого фрагмента 

 Для того, чтобы сохранить фрагмент РЛИ в виде отдельно файла .rli, .bmp 

или .tiff необходимо выбрать меню            на панели инструментов, выделить тре-

буемую область рамкой, кликнуть на нее правой кнопкой мыши и в появившемся 

контекстном меню выбрать пункт Save cut fragment as RLI, Save cut fragment as 

BMP или Save cut fragment as TIFF (Рисунок 3.21) 
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Рисунок 3.21 - Сохранение фрагмента РЛИ 

В появившемся диалоговом окне нужно выбрать директорию для 

сохранения файла РЛИ и нажать Save (Рисунок 3.22). 
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Рисунок 3.22 - Диалог сохранения фрагмента РЛИ 

3.3.13 Оценка полосы захвата 

Для расчета ширины полосы захвата необходимо выбрать на панели 

инструментов меню       . Критерием оценки данной величины является 

падение интенсивности РЛИ на краях относительно центра на 6дБ. Значение 

данного порога, а также значение высоты полета можно изменять в 

соответствующих полях окна. Пересчет значений требуемых величин 

запускается нажатием на кнопку Calculate (Рисунок 3.23). 
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Рисунок 3.23 - Оценка полосы захвата 

3.3.14 Определение разрешающей способности 

Для определения разрешающей способности необходимо выделить на 

РЛИ точечную цель и в контекстном меню выбрать пункт Open in CSV.  

Откроется просмотр профилей выделенной области. 

Далее необходимо выбрать нужный профиль, через переключение по 

строкам или столбцам, выставить нужный уровень через Contour line, нажать 

на панели инструментов окна иконку Intersection width, и навести указателем 

мыши на подсвеченную красным область. После чего появится ее длина в 

координатах исходной голограммы. 
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Рисунок 3.24 - Определение разрешающей способности 

3.3.15 Оценка динамического диапазона (ДД) 

Для оценки ДД РЛИ проводится расчет статистики, посмотреть 

которую можно по нажатию меню             на панели инструментов. 

 

Рисунок 3.25 - Оценка ДД РЛИ 

В таблице приведены значения следующих статистик: среднее 

арифметическое, квадрата среднего, количество точек на РЛИ, максимальное и 

минимальное значение, среднеквадратичное отклонение (СКО) и дисперсия. 
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3.3.16 Вычисление диаграммы направленности антенны 

Для вычисления диаграммы направленности антенны необходимо 

выбрать на панели инструментов меню         .  

 

Рисунок 3.26 - Диаграмма направленности антенны 

Под диаграммой направленности антенны (ДНА) в данном случае 

понимается азимутальный спектр (вдоль путевой координаты носителя) не 

сжатой по азимуту, но сжатой по дальности голограммы. Предполагается что 

спектр промодулирован формой ДНА по азимуту. В спектре также виден 

эффект доплеровского сдвига, обусловленный отклонением антенны. 

В этом окне можно переключать отображение оси X с частот, в угловые 

координаты с помощью переключателя (Рисунок 3.26). 

Для просмотра точных значений, требуется навести на нужное 

значение указателем мыши, после чего в левом нижнем углу окна, будут 

отображены ее координаты в заданной сетке. 
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3.3.17  Оценка уровня шумов данных по участкам их априорного от-

сутствия 

Для оценки уровня шумов (статистики) необходимо выбрать на панели 

инструментов меню         . Выделить с помощью рамки область, оценку 

которой нужно произвести, кликнуть на нее правой кнопкой мыши и в 

появившемся контекстном меню выбрать пункт Statistics of selection. 

 

Рисунок 3.27 - Оценка уровня шумов данных 
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